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Module 1 
Introduction to Microsoft SQL Server 2014 

Contents: 
Lesson 2: SQL Server Editions and Versions 2 

Lesson 3: Getting Started with SQL Server Management Studio 4 

Module Review and Takeaways 7 
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Lesson 2 
SQL Server Editions and Versions 
Contents: 
Question and Answers 3 
Resources 3 
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Question and Answers 

SQL Server Versions 
Question: Have you worked with any versions of SQL Server prior to SQL Server 2012? 

 Answer: Answers will vary. 

 
Resources 

SQL Server in the Cloud 
    Additional Reading: For more information on the use of T-SQL in Microsoft Azure SQL Databases, 

go to the MSDN article Transact-SQL Support (Microsoft Azure SQL Database): 
http://go.microsoft.com/fwlink/?LinkID=394805 
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Lesson 3 
Getting Started with SQL Server Management Studio 
Contents: 
Question and Answers 5 
Demonstration: Introducing Microsoft SQL Server 2014 5 
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Question and Answers 

Connecting to SQL Server 
Question: Which authentication method do you use to log on to SQL Server in your organization? 

 
Demonstration: Introducing Microsoft SQL Server 2014 

Demonstration Steps 
Use SSMS to connect to an on-premises instance of SQL Server 2014 
1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 

log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod01\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

Explore databases and other objects 
1. If the Object Explorer pane is not visible, click View and click Object Explorer. 

2. Expand the Databases folder to see the list of databases. 

3. Expand the AdventureWorks database. 

4. Expand the Tables folder. 

5. Expand the Sales.Customer table. 

6. Expand the Columns folder. 

7. Show the list of columns, and point out the data type information for the ModifiedDate column. 

Work with T-SQL scripts 
1. If the Solution Explorer pane is not visible, click View and click Solution Explorer. Initially, it will be 

empty. 

2. Click the File menu, click New, click Project. 

3. In the New Project box, under Installed Templates, click SQL Server Management Studio 
Projects.  

4. In the middle pane, click SQL Server Scripts. 

5. In the Name box, type Module 1 Demonstration. 

6. In the Location box, type or browse to D:\Demofiles\Mod01. 

7. Point out the solution name, then click OK. 

8. In the Solution Explorer pane, right-click Queries, then click New Query. 

9. Type the following T-SQL code: 

USE AdventureWorks; 
GO 
SELECT CustomerID, AccountNumber 
FROM Sales.Customer; 

10. Select the code and click Execute on the toolbar. 

11. Point out the results pane. 

12. Click File, and then click Save All. 
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13. Click File, and then click Close Solution. 

14. Click File, click Recent Projects and Solutions, and then click Module 1 Demonstration.ssmssln. 

15. Point out the Solution Explorer pane. 

16. Close SQL Server Management Studio without saving any files. 



Introduction to Microsoft SQL Server 2014    1-7 

Module Review and Takeaways 
Review Question(s) 
Question: Can an SQL Server database be stored across multiple instances? 

 Answer: No, a database is completely contained within a single instance. 

 
Question: If no T-SQL code is selected in a script window, which lines will be run when you click the 
Execute button? 

 Answer: All statements in the script will be executed. 

 
Question: What does an SQL Server Management Studio solution contain? 

 Answer: Projects. 
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Module 2 
Introduction to T-SQL Querying 

Contents: 
Lesson 1: Introducing T-SQL 2 

Lesson 2: Understanding Sets 4 

Lesson 4: Understanding the Logical Order of Operations in SELECT Statements 6 

Module Review and Takeaways 8 
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Lesson 1 
Introducing T-SQL 
Contents: 
Demonstration: T-SQL Language Elements 3 
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Demonstration: T-SQL Language Elements 

Demonstration Steps 
Use T-SQL Language Elements 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod02\Setup.cmd as administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod02\Demo folder. 

5. On the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Understanding Sets 
Contents: 
Resources 5 
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Resources 

Set Theory and SQL Server 

    Additional Reading: More information on the set theory and its application to SQL Server 
queries can be found in Chapter 1 of Itzik Ben-Gan’s Inside Microsoft® SQL Server® 2008: T-SQL 
Querying (Microsoft Press, 2009) and Chapter 2 of Itzik Ben-Gan’s Microsoft SQL Server 2008: T-
SQL Fundamentals (Microsoft Press, 2008). For more information on the use of "Set of all…" see 
Joe Celko's Thinking in Sets (Morgan Kaufman, 2008). 
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Lesson 4 
Understanding the Logical Order of Operations in 
SELECT Statements 
Contents: 
Demonstration: Logical Query Processing 7 
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Demonstration: Logical Query Processing 

Demonstration Steps 
View Query Output that Illustrates Logical Processing Order 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod02\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod02\Demo folder. 

3. On the View menu, click Solution Explorer.  Then open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 
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Module Review and Takeaways 
Review Question(s) 
Question: Which category of T-SQL statements concerns querying and modifying data? 

 Answer: DML 

 
Question: What are some examples of aggregate functions supported by T-SQL? 

 Answer: SUM, MIN, COUNT, MAX, AVG 

 
Question: Which SELECT statement element will be processed before a WHERE clause? 

 Answer: FROM 

 



Writing SELECT Queries    3-1 

Module 3 
Writing SELECT Queries 

Contents: 
Lesson 1: Writing Simple SELECT Statements 2 

Lesson 2: Eliminating Duplicates with DISTINCT 4 

Lesson 3: Using Column and Table Aliases 6 

Lesson 4: Writing Simple CASE Expressions 8 

Module Review and Takeaways 10 
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Lesson 1 
Writing Simple SELECT Statements 
Contents: 
Demonstration: Writing Simple SELECT Statements 3 
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Demonstration: Writing Simple SELECT Statements 

Demonstration Steps 
Use Simple SELECT Queries 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod03\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod03\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Eliminating Duplicates with DISTINCT 
Contents: 
Demonstration: Eliminating Duplicates with DISTINCT 5 
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Demonstration: Eliminating Duplicates with DISTINCT 

Demonstration Steps 
Eliminate Duplicate Rows 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod03\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod03\Demo folder. 

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Using Column and Table Aliases 
Contents: 
Question and Answers 7 
Demonstration: Using Column and Table Aliases 7 
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Question and Answers 

Using Aliases to Refer to Columns 
Question: Which style of column aliases do you prefer? Why? 

 
Demonstration: Using Column and Table Aliases 

Demonstration Steps 
Use Column and Table Aliases 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod03\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod03\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 4 
Writing Simple CASE Expressions 
Contents: 
Demonstration: Using a Simple CASE Expression 9 
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Demonstration: Using a Simple CASE Expression 

Demonstration Steps 
Use a Simple CASE Expression 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod03\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod03\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Best Practice 
Terminate all T-SQL statements with a semicolon. This will make your code more readable, avoid certain 
parsing errors, and protect your code against changes in future versions of SQL Server. 

Consider standardizing your code on the AS keyword for labeling column and table aliases. This will make 
it easier to read and avoids accidental aliases. 

Review Question(s) 
Question: Why is the use of SELECT * not a recommended practice? 

 Answer: Looking for two answers: 1) * asks for all columns, which is typically too much.  

2) Query exposed to changes in underlying table structure. 

 
Question: What will happen if you omit a comma between column names in a SELECT clause? 

 Answer: An accidental alias is created. 

 
Question: What kind of result does a simple CASE statement return? 

 Answer: Scalar (single-value). 
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Module 4 
Querying Multiple Tables 

Contents: 
Lesson 1: Understanding Joins 2 

Lesson 2: Querying with Inner Joins 4 

Lesson 3: Querying with Outer Joins 6 

Lesson 4: Querying with Cross Joins and Self Joins 8 

Module Review and Takeaways 10 
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Lesson 1 
Understanding Joins 
Contents: 
Demonstration: Understanding Joins 3 
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Demonstration: Understanding Joins 

Demonstration Steps 
Use Joins 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod04\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod04\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Querying with Inner Joins 
Contents: 
Demonstration: Querying with Inner Joins 5 
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Demonstration: Querying with Inner Joins 

Demonstration Steps 
Use Inner Joins 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod04\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod04\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Querying with Outer Joins 
Contents: 
Demonstration: Querying with Outer Joins 7 
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Demonstration: Querying with Outer Joins 

Demonstration Steps 
Use Outer Joins 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod04\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod04\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 4 
Querying with Cross Joins and Self Joins 
Contents: 
Demonstration: Querying with Cross Joins and Self Joins 9 
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Demonstration: Querying with Cross Joins and Self Joins 

Demonstration Steps 
Use Self Joins and Cross Joins 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod04\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod04\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Best Practice 
Table aliases should always be defined when joining tables. 

Joins should be expressed using SQL-92 syntax, with JOIN and ON keywords. 

 
Review Question(s) 
Question: How does an inner join differ from an outer join? 

 Answer: An inner join filters out rows which do not satisfy the predicate in the ON clause. An 
outer join includes all rows from both tables and includes NULLs for attributes where no match is 
found. 

 
Question: Which join types include a logical Cartesian product? 

 Answer: CROSS, INNER and OUTER 

. 

Question: Can a table be joined to itself? 

 Answer: Yes, as a self join. An alias to at least one table is required in the FROM clause. 
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Module 5 
Sorting and Filtering Data 

Contents: 
Lesson 1: Sorting Data 2 

Lesson 2: Filtering Data with Predicates 4 

Lesson 3: Filtering Data with TOP and OFFSET-FETCH 6 

Lesson 4: Working with Unknown Values 8 

Module Review and Takeaways 10 
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Lesson 1 
Sorting Data 
Contents: 
Question and Answers 3 
Demonstration: Sorting Data 3 
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Question and Answers 

Sorting Data 
Question: Does the physical order of rows in an SQL Server table guarantee any sort order in queries 
using the table? 

 Answer: No. 

 
Demonstration: Sorting Data 

Demonstration Steps 
Sort Data Using the ORDER BY Clause 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod05\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod05\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Filtering Data with Predicates 
Contents: 
Demonstration: Filtering Data with Predicates 5 
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Demonstration: Filtering Data with Predicates 

Demonstration Steps 
Filter Data in a WHERE Clause 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod05\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod05\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Filtering Data with TOP and OFFSET-FETCH 
Contents: 
Demonstration: Filtering Data with TOP and OFFSET-FETCH 7 
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Demonstration: Filtering Data with TOP and OFFSET-FETCH 

Demonstration Steps 
Filter Data Using TOP and OFFSET-FETCH 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod05\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod05\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 4 
Working with Unknown Values 
Contents: 
Demonstration: Working with NULL 9 
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Demonstration: Working with NULL 

Demonstration Steps 
Test for NULL 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod05\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod05\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Best Practice 
You should always use an ORDER BY clause if you need records returned in a specific order. Even if the 
results are returned correctly without an ORDER BY clause, this cannot be guaranteed and might not 
always be the case. 

Ensure that you handle NULL values correctly. NULL values are unknown and are not the same a s a zero-
length string or the number 0, which are both known values. 
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Module 6 
Working with SQL Server 2014 Data Types 

Contents: 
Lesson 1: Introducing SQL Server 2014 Data Types 2 

Lesson 2: Working with Character Data 4 

Lesson 3: Working with Date and Time Data 6 

Module Review and Takeaways 8 
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Lesson 1 
Introducing SQL Server 2014 Data Types 
Contents: 
Resources 3 
Demonstration: SQL Server Data Types 3 
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Resources 

Other Data Types 

    Additional Reading: See course 20464C: Developing Microsoft® SQL Server® Databases 
for additional information on the XML data type.  
 

    Additional Reading: Go to course 20464C: Developing Microsoft® SQL Server® Databases 
for additional information about the hierarchyid data type.  

 
Demonstration: SQL Server Data Types 

Demonstration Steps 
Convert Data Types 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod06\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod06\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 

  



6-4    Querying Microsoft® SQL Server® 

Lesson 2 
Working with Character Data 
Contents: 
Demonstration: Working with Character Data 5 
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Demonstration: Working with Character Data 

Demonstration Steps 
Manipulate Character Data 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod06\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod06\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Working with Date and Time Data 
Contents: 
Demonstration: Working with Date and Time Data 7 
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Demonstration: Working with Date and Time Data 

Demonstration Steps 
Query Data and Time Values 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod06\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod06\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: Will SQL Server be able to successfully implicitly convert an int data type to a varchar? 

 Answer: No, int has higher type precedence. 

 
Question: What data type is suitable for storing flag information, such as TRUE or FALSE?  

 Answer: Bit 

 
Question: What logical operators are useful for retrieving ranges of date and time values? 

 Answer: >=, < 
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Module 7 
Using DML to Modify Data 

Contents: 
Lesson 1: Adding Data to Tables 2 

Lesson 2: Modifying and Removing Data 4 

Module Review and Takeaways 6 
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Lesson 1 
Adding Data to Tables 
Contents: 
Demonstration: Inserting Data Into Tables 3 
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Demonstration: Inserting Data Into Tables 

Demonstration Steps 
Insert Rows Into Tables 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod07\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod07\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 

  



07-4    Querying Microsoft® SQL Server® 

Lesson 2 
Modifying and Removing Data 
Contents: 
Demonstration: Modifying and Removing Data From Tables 5 
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Demonstration: Modifying and Removing Data From Tables 

Demonstration Steps 
Update and Delete Data in a Table 

1. On the virtual machine, on the Taskbar, click Ensure that you have completed the previous 
demonstration in this module. Alternatively, start the 20461C-MIA-DC and 20461C-MIA-SQL virtual 
machines, log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password 
Pa$$w0rd, and run D:\Demofiles\Mod07\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod07\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: What attributes of the source columns are transferred to a table created with a SELECT INTO 
query?  

 Answer: Name, data type and nullability. 

 
Question: The presence of which constraint prevents TRUNCATE TABLE from executing?  

 Answer: A foreign key reference to the table. 
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Module 8 
Using Built-In Functions 

Contents: 
Lesson 1: Writing Queries with Built-In Functions 2 

Lesson 2: Using Conversion Functions 4 

Lesson 3: Using Logical Functions 6 

Lesson 4: Using Functions to Work with NULL 8 

Module Review and Takeaways 10 
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Lesson 1 
Writing Queries with Built-In Functions 
Contents: 
Demonstration: Writing Queries Using Built-In Functions 3 
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Demonstration: Writing Queries Using Built-In Functions 

Demonstration Steps 
Use Built-in Scalar Functions 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod08\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod08\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 

. 
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Lesson 2 
Using Conversion Functions 
Contents: 
Demonstration: Using Conversion Functions 5 
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Demonstration: Using Conversion Functions 

Demonstration Steps 
Use Functions to Convert Data 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod08\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod08\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Using Logical Functions 
Contents: 
Demonstration: Using Logical Functions 7 
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Demonstration: Using Logical Functions 

Demonstration Steps 
Use Logical Functions 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod08\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod08\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 4 
Using Functions to Work with NULL 
Contents: 
Demonstration: Using Functions to Work with NULL 9 
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Demonstration: Using Functions to Work with NULL 

Demonstration Steps 
Use Functions to Work with NULL 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod08\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod08\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Best Practice 
When possible, use standards-based functions such as CAST or COALESCE rather than SQL Server-specific 
functions like NULLIF or CONVERT. 

Consider the impact of functions in a WHERE clause on query performance. 

Review Question(s) 
Question: Which function should you use to convert from an int to a nchar(8)?  

 Answer: CAST is the preferred conversion function because it is ANSI-standard. 

 
Question: Which functions will return a NULL, rather than an error message, if it cannot convert a string 
to a date?  

 Answer: TRY_PARSE and TRY_CONVERT will attempt a conversion, just like PARSE and CONVERT, 
respectively. However, instead of raising a runtime error, failed conversions return NULL. 

 
Question: What is the name for a function that returns a single value?  

 Answer: Scalar functions return a single value. 
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Module 9 
Grouping and Aggregating Data 

Contents: 
Lesson 1: Using Aggregate Functions 2 

Lesson 2: Using the GROUP BY Clause 4 

Lesson 3: Filtering Groups with HAVING 6 

Module Review and Takeaways 8 
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Lesson 1 
Using Aggregate Functions 
Contents: 
Demonstration: Using Aggregate Functions 3 
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Demonstration: Using Aggregate Functions 

Demonstration Steps 
Use Built-in Aggregate Functions 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod09\Setup.cmd as an administrator. 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod09\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Using the GROUP BY Clause 
Contents: 
Demonstration: Using GROUP BY 5 
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Demonstration: Using GROUP BY 

Demonstration Steps 
Use the GROUP BY Clause 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod09\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod09\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Filtering Groups with HAVING 
Contents: 
Demonstration: Filtering Groups with HAVING 7 
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Demonstration: Filtering Groups with HAVING 

Demonstration Steps 
Filter Grouped Data Using the HAVING Clause 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod09\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod09\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: What is the difference between the COUNT function and the COUNT_BIG function? 

 Answer: COUNT returns an int; COUNT_BIG returns a big_int. 

 
Question: Can a GROUP BY clause include more than one column? 

 Answer: Yes, separated by commas. 

 
Question: Can a WHERE clause and a HAVING clause in a query filter on the same column? 

 Answer: Yes. 
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Module 10 
Using Subqueries 

Contents: 
Lesson 1: Writing Self-Contained Subqueries 2 

Lesson 2: Writing Correlated Subqueries 4 

Lesson 3: Using the EXISTS Predicate with Subqueries 6 

Module Review and Takeaways 8 
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Lesson 1 
Writing Self-Contained Subqueries 
Contents: 
Demonstration: Writing Self-Contained Subqueries 3 
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Demonstration: Writing Self-Contained Subqueries 

Demonstration Steps 
Write a Nested Subquery 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod10\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod10\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Writing Correlated Subqueries 
Contents: 
Demonstration: Writing Correlated Subqueries 5 
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Demonstration: Writing Correlated Subqueries 

Demonstration Steps 
Write a Correlated Subquery 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod10\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod10\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Using the EXISTS Predicate with Subqueries 
Contents: 
Demonstration: Writing Subqueries Using EXISTS 7 
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Demonstration: Writing Subqueries Using EXISTS 

Demonstration Steps 
Write Queries Using EXISTS and NOT EXISTS 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod10\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod10\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: Can a correlated subquery return a multi-valued set?  

 Answer: Yes. 

 
Question: What type of subquery may be rewritten as a JOIN?  

 Answer: Correlated subqueries. 

 
Question: Which columns should appear in the SELECT list of a subquery following the EXISTS predicate?  

 Answer: Only a * needs to be specified. No actual columns will be retrieved. 
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Module 11 
Using Table Expressions 

Contents: 
Lesson 1: Using Views 2 

Lesson 2: Using Inline TVFs 4 

Lesson 3: Using Derived Tables 6 

Lesson 4: Using CTEs 8 

Module Review and Takeaways 10 
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Lesson 1 
Using Views 
Contents: 
Resources 3 
Demonstration: Using Views 3 
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Resources 

Writing Queries That Return Results from Views 

    Additional Reading: For more information on database security, see the Microsoft Course 
20462C: Administering a Microsoft SQL Server Database.  

 
Demonstration: Using Views 

Demonstration Steps 
Create Views 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod11\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod11\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 

  



11-4    Querying Microsoft® SQL Server® 

Lesson 2 
Using Inline TVFs 
Contents: 
Demonstration: Inline TVFs 5 
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Demonstration: Inline TVFs 

Demonstration Steps 
Create Inline TVFs 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod11\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod11\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Using Derived Tables 
Contents: 
Demonstration: Using Derived Tables 7 
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Demonstration: Using Derived Tables 

Demonstration Steps 
Write Queries that Create Derived Tables 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod11\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod11\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 

  



11-8    Querying Microsoft® SQL Server® 

Lesson 4 
Using CTEs 
Contents: 
Demonstration: Using CTEs 9 
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Demonstration: Using CTEs 

Demonstration Steps 
Write Queries that Create CTEs 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod11\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod11\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: When would you use a CTE rather than a derived table for a query?  

 Answer: CTEs may be written once, referenced multiple times in a query. 

 
Question: Which table expressions allow variables to be passed in as parameters to the expression? 

 Answer: Table-valued functions. 
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Module 12 
Using Set Operators 

Contents: 
Lesson 1: Writing Queries with the UNION Operator 2 

Lesson 2: Using EXCEPT and INTERSECT 4 

Lesson 3: Using APPLY 6 

Module Review and Takeaways 8 
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Lesson 1 
Writing Queries with the UNION Operator 
Contents: 
Demonstration: Using UNION and UNION ALL 3 
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Demonstration: Using UNION and UNION ALL 

Demonstration Steps 
Use UNION and UNION ALL 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod12\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod12\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Using EXCEPT and INTERSECT 
Contents: 
Demonstration: Using EXCEPT and INTERSECT 5 

  



Using Set Operators    12-5 

Demonstration: Using EXCEPT and INTERSECT 

Demonstration Steps 
Use INTERSECT and EXCEPT 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod12\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod12\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Using APPLY 
Contents: 
Demonstration: Using CROSS APPLY and OUTER APPLY 7 
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Demonstration: Using CROSS APPLY and OUTER APPLY 

Demonstration Steps 
Use APPLY 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod12\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod12\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Question: Which set operator would you use to combine sets if you knew there were no duplicates and 
wanted better performance? 

 Answer: UNION ALL. 

 
Question: Which APPLY form will not return rows from the left table if the result of the right table 
expression was empty? 

 Answer: CROSS APPLY. 

 
Question: What is the difference between APPLY and JOIN? 

 Answer: APPLY can take the output of a TVF. 
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Module 13 
Using Window Ranking, Offset, and Aggregate Functions 

Contents: 
Lesson 1: Creating Windows with OVER 2 

Lesson 2: Exploring Window Functions 4 

Module Review and Takeaways 6 
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Lesson 1 
Creating Windows with OVER 
Contents: 
Demonstration: Using OVER and Partitioning 3 
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Demonstration: Using OVER and Partitioning 

Demonstration Steps 
Use OVER, PARTITION BY, and ORDER BY Clauses 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod13\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod13\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Exploring Window Functions 
Contents: 
Demonstration: Exploring Windows Functions 5 
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Demonstration: Exploring Windows Functions 

Demonstration Steps 
Use Window Aggregate, Ranking, and Offset Functions 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod13\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod13\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: What results will be returned by a ROW_NUMBER function if there is no ORDER BY clause in 
the query? 

 Answer: An unordered set. 

 
Question: Which ranking function would you use to return the values 1,1,3? Which would return 1,1,2? 

 Answer: RANK, DENSE_RANK. 

 
Question: Can a window frame extend beyond the boundaries of the window partition defined in the 
same OVER() clause? 

 Answer: No. 
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Module 14 
Pivoting and Grouping Sets 

Contents: 
Lesson 1: Writing Queries with PIVOT and UNPIVOT 2 

Lesson 2: Working with Grouping Sets 4 

Module Review and Takeaways 6 
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Lesson 1 
Writing Queries with PIVOT and UNPIVOT 
Contents: 
Demonstration: Writing Queries with PIVOT and UNPIVOT 3 
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Demonstration: Writing Queries with PIVOT and UNPIVOT 

Demonstration Steps 
Use PIVOT and UNPIVOT 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod14\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod14\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Working with Grouping Sets 
Contents: 
Demonstration: Using Grouping Sets 5 
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Demonstration: Using Grouping Sets 

Demonstration Steps 
Use the CUBE and ROLLUP Subclauses 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod14\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod14\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: Once a dataset has been pivoted with aggregation, can the original detail rows be restored 
with an unpivot operation?  

 Answer: No, the original detail is lost during aggregation. 

 
Question: What are the possible sources of NULLs returned by a query using grouping sets to 
create aggregations? 

 Answer: NULLs might be present in the underlying source data, or may be placeholders for rows 
that do not participate in the group member. 

 
Question: Which subclause infers a hierarchy of columns to create meaningful grouping sets? 

 Answer: ROLLUP. 
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Module 15 
Executing Stored Procedures 

Contents: 
Lesson 1: Querying Data with Stored Procedures 2 

Lesson 2: Passing Parameters to Stored Procedures 4 

Lesson 3: Creating Simple Stored Procedures 6 

Lesson 4: Working with Dynamic SQL 8 

Module Review and Takeaways 10 
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Lesson 1 
Querying Data with Stored Procedures 
Contents: 
Demonstration: Querying Data with Stored Procedures 3 
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Demonstration: Querying Data with Stored Procedures 

Demonstration Steps 
Use Stored Procedures 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod15\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod15\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Passing Parameters to Stored Procedures 
Contents: 
Demonstration: Passing Parameters to Stored Procedures 5 
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Demonstration: Passing Parameters to Stored Procedures 

Demonstration Steps 
Pass Parameters to a Stored Procedure 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod15\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod15\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Creating Simple Stored Procedures 
Contents: 
Demonstration: Creating Simple Stored Procedures 7 
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Demonstration: Creating Simple Stored Procedures 

Demonstration Steps 
Create a Stored Procedure 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod15\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod15\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 4 
Working with Dynamic SQL 
Contents: 
Demonstration: Working with Dynamic SQL 9 
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Demonstration: Working with Dynamic SQL 

Demonstration Steps 
Execute Dynamic SQL Queries 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod15\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod15\Demo folder. 

3. In Solution Explorer, open the 41 – Demonstration D.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: What benefits do stored procedures provide for data retrieval that views do not?  

 Answer: Answers may vary, but ability to accept parameters is what we're looking for. 

 
Question: What form should parameter and value pairs take when passed to a stored procedure in the 
EXECUTE statement?   

 Answer: @NAME = VALUE. 

 
Question: Which method for constructing dynamic SQL allows parameters to be passed at runtime?  

 Answer: Using sp_executesql. 

 



Programming with T-SQL    16-1 

Module 16 
Programming with T-SQL 

Contents: 
Lesson 1: T-SQL Programming Elements 2 

Lesson 2: Controlling Program Flow 4 

Module Review and Takeaways 6 
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Lesson 1 
T-SQL Programming Elements 
Contents: 
Demonstration: T-SQL Programming Elements 3 
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Demonstration: T-SQL Programming Elements 

Demonstration Steps 
Control Batch Execution and Variable Usage 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod16\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod16\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Controlling Program Flow 
Contents: 
Demonstration: Controlling Program Flow 5 
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Demonstration: Controlling Program Flow 

Demonstration Steps 
Control the Flow of Execution 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod16\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod16\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files 
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Module Review and Takeaways 
Review Question(s) 
Question: Can you declare a variable in one batch and reference it in multiple batches?  

 Answer: No, variables are local to the batch in which they are declared. 

 
Question: Can you create a synonym that references an object that does not exist yet?  

 Answer: Yes, resolution doesn't occur until the synonym is used. 

 
Question: Will a WHILE loop exit when the predicate evaluates to NULL?  

 Answer: Yes. 
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Module 17 
Implementing Error Handling 

Contents: 
Lesson 1: Implementing T-SQL Error Handling 2 

Lesson 2: Implementing Structured Exception Handling 4 

Module Review and Takeaways 6 
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Lesson 1 
Implementing T-SQL Error Handling 
Contents: 
Question and Answers 3 
Demonstration: Handling Errors Using T-SQL 3 
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Question and Answers 

Raising Errors Using RAISERROR 
Question: Why might you want to intentionally raise an error in your code? 

 Answer: An error is one means of communicating to the person or procedure responsible for 
executing the code. There might well be a condition that does not raise a SQL Server error, but, 
nevertheless, needs reporting. For example, if you update all orders made by a particular 
customer, but no orders are found, you might want this flagged. 

 
Raising Custom Errors 
Question: What do the DB_ID and DB_NAME functions return? 

 Answer: DB_ID returns the database ID number and DB_NAME returns the database name. 

 
Creating Alerts When Errors Occur 
Question: Can you suggest an example of an error that would require immediate attention from an 
administrator? 

 Answer: Answers will vary. 

 
Demonstration: Handling Errors Using T-SQL 

Demonstration Steps 
Handle Errors 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod17\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod17\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Implementing Structured Exception Handling 
Contents: 
Question and Answers 5 
Demonstration: Applying Retry Logic to Deadlocks 5 
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Question and Answers 

TRY/CATCH Block Programming 
Question: In what situation might it have been useful to be able to raise a system error? 

 Answer: System errors can be useful because they can be logged in the server logging system. 

 
Demonstration: Applying Retry Logic to Deadlocks 

Demonstration Steps 
Apply Retry Logic to a Deadlock 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod17\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod17\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: Which error types cannot by caught by structured exception handling? 

 Answer: Compile/syntax errors, as well as some delayed name resolution errors. 

 
Question: Can TRY/CATCH blocks be nested? 

 Answer: Yes. 

 
Question: How can you use THROW outside of a CATCH block? 

 Answer: With arguments that raise a user-defined error. 
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Module 18 
Implementing Transactions 

Contents: 
Lesson 1: Transactions and the Database Engine 2 

Lesson 2: Controlling Transactions 4 

Module Review and Takeaways 6 
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Lesson 1 
Transactions and the Database Engine 
Contents: 
Demonstration: Transactions and the Database Engine 3 
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Demonstration: Transactions and the Database Engine 

Demonstration Steps 
Use Transactions 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod18\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod18\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Controlling Transactions 
Contents: 
Demonstration: Controlling Transactions 5 
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Demonstration: Controlling Transactions 

Demonstration Steps 
Control Transactions 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod18\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod18\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: What happens to a nested transaction when the outer transaction is rolled back? 

 Answer: The inner transaction is also rolled back, so nested transactions are not typically useful 
in user code. 

 
Question: When a runtime error occurs in a transaction and SET XACT_ABORT is ON, is the transaction 
always automatically rolled back? 

 Answer: No, not if the error occurs within a TRY block. 
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Module 19 
Improving Query Performance 

Contents: 
Lesson 1: Factors in Query Performance 2 

Lesson 2: Displaying Query Performance Data 4 

Module Review and Takeaways 6 
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Lesson 1 
Factors in Query Performance 
Contents: 
Demonstration: Factors in Query Performance 3 
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Demonstration: Factors in Query Performance 

Demonstration Steps 
Rewrite a Cursor as a Set-based Query 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod19\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod19\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Displaying Query Performance Data 
Contents: 
Demonstration: Displaying Query Performance Data 5 
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Demonstration: Displaying Query Performance Data 

Demonstration Steps 
Display Execution Plans and Query Statistics 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod19\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod19\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 
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Module Review and Takeaways 
Review Question(s) 
Question: Why should you avoid the use of * in a SELECT clause?  

 Answer: Answers will vary, but should include performance and risk of changes to table design 
breaking a client application. 

 
Question: How many clustered indexes are permitted per table?  

 Answer: One. 

 
Question: Which type of execution plan can be displayed without running a query?  

 Answer: Estimated. 
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Module 20 
Querying SQL Server Metadata 

Contents: 
Lesson 1: Querying System Catalog Views and Functions 2 

Lesson 2: Executing System Stored Procedures 4 

Lesson 3: Querying Dynamic Management Objects 6 

Module Review and Takeaways 8 
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Lesson 1 
Querying System Catalog Views and Functions 
Contents: 
Demonstration: Querying System Catalog Views and Functions 3 
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Demonstration: Querying System Catalog Views and Functions 

Demonstration Steps 
Query System Catalog Views and Functions 

1. Ensure that the 20461C-MIA-DC and 20461C-MIA-SQL virtual machines are both running, and then 
log on to 20461C-MIA-SQL as ADVENTUREWORKS\Student with the password Pa$$w0rd. 

2. Run D:\Demofiles\Mod20\Setup.cmd as an administrator 

3. Start SQL Server Management Studio and connect to the MIA-SQL database engine instance using 
Windows authentication. 

4. Open the Demo.ssmssln solution in the D:\Demofiles\Mod20\Demo folder. 

5. If the Solution Explorer pane is not visible, on the View menu, click Solution Explorer.  

6. Open the 11 – Demonstration A.sql script file. 

7. Follow the instructions contained within the comments of the script file. 

8. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 2 
Executing System Stored Procedures 
Contents: 
Demonstration: Executing System Stored Procedures 5 
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Demonstration: Executing System Stored Procedures 

Demonstration Steps 
Execute System Stored Procedures 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod20\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod20\Demo folder.  

3. In Solution Explorer, open the 21 – Demonstration B.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Keep SQL Server Management Studio open for the next demonstration. 
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Lesson 3 
Querying Dynamic Management Objects 
Contents: 
Demonstration: Querying Dynamic Management Objects 7 

  



Querying SQL Server Metadata    20-7 

Demonstration: Querying Dynamic Management Objects 

Demonstration Steps 
Query System Dynamic Management Objects 

1. Ensure that you have completed the previous demonstration in this module. Alternatively, start the 
20461C-MIA-DC and 20461C-MIA-SQL virtual machines, log on to 20461C-MIA-SQL as 
ADVENTUREWORKS\Student with the password Pa$$w0rd, and run 
D:\Demofiles\Mod20\Setup.cmd as an administrator. 

2. If SQL Server Management Studio is not already open, start it and connect to the MIA-SQL database 
engine instance using Windows authentication, and then open the Demo.ssmssln solution in the 
D:\Demofiles\Mod20\Demo folder. 

3. In Solution Explorer, open the 31 – Demonstration C.sql script file. 

4. Follow the instructions contained within the comments of the script file. 

5. Close SQL Server Management Studio without saving any files. 



20-8    Querying Microsoft® SQL Server® 

Module Review and Takeaways 
Review Question(s) 
Question: Why might you choose to query a system view rather than a system stored procedure which 
returned the same metadata? 

 Answer: Unlike procedures, views may be filtered, joined and further processed. 

 
Question: What issues might you face later if your application used SELECT * to query system catalog 
views? 

 Answer: System views may be changed and columns may be added in future releases of SQL 
Server. 
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